5
Presentations
KEY FEATURES


Collaborative presentations



Cloud storage



Share presentations with teachers, students, and parents



Insert image and video



Publish presentation to the world



Slide transitions and animations

G

oogle Presentations is a powerful presentation maker that is part of Google
Apps for Education. Presentations has all of the features users have come to
expect with traditional presentation software such as Microsoft PowerPoint
and Apple’s Keynote. Slide transitions, animations, inserting images, and video are
all part of Google Presentations. The difference is in sharing, collaboration, and
price. Special features like these will help students and teachers fulfill the requirements of the Common Core State Standards.
Many of the same tools that are used in Documents will be used in Presentations.
Sharing, cloud-based storage, and download as other formats are available in the
same manner as they were in Documents. For example, each presentation made in
Google Presentations is given a unique Web address that when typed into a Web
browser can be viewed or edited depending on the share settings. This is great for
sharing student presentations. For an example of a collaborative presentation made
by students, visit http://goo.gl/GYqTD or snap the quick-response (QR) code in
Figure 5.1 to view the presentation on your smartphone or tablet.
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Figure 5.1 is a QR code. Using a smartphone or
tablet QR code reader application follow the link
to view the presentation on a mobile device.
Common Core State Standards demand students be ready for college and a career. Accessing
information with increased mobility will be a
necessary skill. Read more about QR codes in
Chapter 11.

COMMON CORE
STANDARDS AND
PRESENTATIONS

Presentations are key in communication.
College- and career-ready students will present
information to classmates and coworkers routinely. Preparing students to make high-quality
presentations in the early grades will hone in
their skills as they progress in school. In the
Figure 5.1 QR Code Student Presentation
Common Core State Standards, presenting
information in clear, concise ways will prepare
students for the rigors of communicating to
specific audiences. The Common Core State
Standards for Speaking and Listening demand
that students have an extensive set of skills in
presenting information. The standards on page
8 of the English Language Arts Standards
report, “Students must learn to work together, express and listen carefully to ideas,
integrate information from oral, visual, quantitative, and media sources, evaluate
what they hear, use media and visual displays strategically to help achieve communicative purposes, and adapt speech to context and task.”
Google Presentations meets this requirement by allowing collaborative work and
the ability to easily share that information with peers, parents, and teachers. The standards say that it is the responsibility of all teachers to make sure students are able to
speak and listen with clarity in their particular content areas. Grades K–5 do not separate the speaking and listening standards into content categories like in Grades 6–12.
In Grades 6–12, the speaking and listening standards are broken down to English
Language Arts and Literacy in History/Social Studies, Science, and Technical Subjects.
Anchor Standard 5 for Speaking and Listening found in Table 5.1 embodies
Google Presentations. For example, students may make visually stunning displays
that capture the attention of the audience. Animations and video may be added to
presentations as well as representations of data such as graphs, tables, or charts. All
of this can be done in collaboration and can be shared with the world through share
settings. Google Presentations offer a unique opportunity for students to create, collaborate, and share their work. Presenting about concepts studied is one of the best
learning strategies. It provides a forum for students to research the content, summarize the information, display data in the form of charts, tables, or graphs, and
create visual representations of content with video and images. Making presentations can teach the student how to organize information, letting it flow seamlessly to
the viewer. The Common Core State Standards believe that it is an important skill to
become ready for life after high school. The Anchor Standard in Table 5.1 addresses
digital media and displays of data when making presentations.
Table 5.1 Anchor Standard 5 for Speaking and Listening
Make strategic use of digital media and visual displays of data to express information
and enhance understanding of presentations.

PRESENTATIONS

Consider the standards in Table 5.2. Each one can be directly linked to Google
Presentations. In Table 5.2, the fifth-grade example, multimedia and visual displays
are explicitly mentioned. Fifth-grade teachers not only must teach their subject, but
also must imbed technology by using presentations to meet the standards.
Table 5.2 Fifth-Grade Speaking and Listening Standard SL.5.5
Include multimedia components (e.g., graphics, sound) and visual displays in
presentations when appropriate to enhance the development of main ideas or themes.

Table 5.3 Reading Standard for Literacy in Science and Technical Subjects 6–12
Integrate quantitative or technical information expressed in words in a text with a
version of that information expressed visually (e.g., in a flowchart, diagram, model,
graph, or table).

Table 5.3 explores the writing standards for History, Social Studies, Science, and
Technical subjects for Grades 6–12. These standards increase with complexity over
the years, ending with the creation of living presentations in Grades 11 and 12.
Creating living presentations requires students not only to use the Internet to produce and publish writing, but also to update individual or shared projects with
feedback from teachers, peers, and professionals in the field. Students are no longer
expected to turn in a dead assignment that is meant for only the teacher’s eyes.
Common Core prepares students to create work that matters and that can contribute
to the knowledge base of the topic. Graduating seniors who are college and career
ready can use collaborative writing and presenting tools like Google Apps for
Education to meet the needs they face in the 21st century and beyond.
Table 5.4 displays writing standards for other subjects. The Common Core State
Standards hold all accountable for reading and writing. It is clear that using Google

Table 5.4 W
 riting Standards for Literacy in History/Social Studies, Science, and
Technical Subjects 6–12
6–8
Use technology, including the Internet, to produce and publish writing and present the
relationships between information and ideas clearly and efficiently.
9–10
Use technology, including the Internet, to produce, publish, and update individual or
shared writing products, taking advantage of technology’s capacity to link to other
information and to display information flexibly and dynamically.
11–12
Use technology, including the Internet, to produce, publish, and update individual or shared
writing products in response to ongoing feedback, including new arguments or information.
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Apps for Education can meet the challenges set forth in the new Common Core State
Standards.

Same Great Features
All of the programs in Google Docs, Presentations, Documents, Spreadsheets,
Drawings and Forms have the same great features. This chapter will focus on these
programs plus Presentation-specific features that make this software ideal for implementing Common Core State Standards.
•
•
•
•
•
•

Sharing
Collaboration
Publish to the Web
Embed
Every Doc has a unique URL
All Docs are stored in Google Drive cloud-based storage

Accessing Presentations
All of the Google Docs share a common pathway to be accessed. Follow the steps
here to start working with Presentations. When the user is logged into her Google
Apps account, Figure 5.2 will be at the top left of the page. Alternatively, the user
may type in any Web browser’s address bar drive.google.com/a/yourschool.org
(replace yourschool.org with your school’s domain address) to access the Documents
List without going through Gmail. To access Presentations, follow these steps:
1. Click on Drive located at the top of the screen as denoted in Figure 5.2 to access
the users Documents List.

Figure 5.2 Accessing Drive

1

2. Click the red Create
button on the left-hand side of the page as shown in
Figure 5.3 to reveal the drop-down menu displaying all of the Google Docs software.
3. Click Presentation to access the presentation editor.

PRESENTATIONS

After clicking on Presentations, the next screen
will ask the user to choose a theme for the background of the slides. When working collaboratively
on presentations, take note that when a theme is
chosen, it is applied to all slides. For example, if a
group of students is working on a collaborative presentation and each student is responsible for a particular set of slides, then if any of the group
members changes or chooses a theme on the shared
presentation, it is applied to all slides. Look at
Figure 5.4 to see an example of theme choices.

Name the Presentation
The next step in creating a Google Presentation
is to give the presentation a name. Students need to
be aware that naming Google Docs they create
ensures that they can easily retrieve the file. To give
a Presentation or any other Google Doc names, follow these steps:
1. Click on the words Untitled presentation as
shown in Figure 5.5.
2. Type your new title of the presentation in the box
in Figure 5.6.
3. Click the box OK when finished.

Figure 5.4 Accessing Drive
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Figure 5.3 Accessing Presentation Editor

2

3
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TECHNOLOGY-INFUSED TEACHING TIP
Instruct students to give names to their work based on a predefined formula. Students
will create a massive amount of digital content over their lifetimes, and it will most
likely be saved in a cloud storage space like in Google Drive. It is important for students
to learn how to manage the content they create. Managing student’s quality of work
over time could be a valuable part of a student’s electronic portfolio. It is imperative
that the information be easy for the student to recall years later. Giving the documents
searchable names that follow a formula will make it easy. For example, the student
Marcy Tolbert will name documents she creates by defining what type of assignment
and adding her name (e.g., “Marcy Tolbert History of NASA Presentation”). Teachers
should require this or a similar naming convention to be able to search for Marcy’s
documents for grading, and later in her school career, she can access these documents
to see her progress over time. Students need to be aware that organizing their digital
life is an important task. Students who are college and career ready realize that digital
organization will be a skill that is in demand in the professional world. A recent Time
magazine article on learning reports that when students are asked questions, they tend
not to think of a particular class. Instead, they think of where the nearest device is
located to search for the information. Students and adults alike are thinking in terms of
search rather than being able to instantly recall the fact. Learning to search the massive
amount of digital content that the user produces or others produce is more important
than the futile attempt to memorize it.

Figure 5.5 Giving the Presentation a Title

1

Figure 5.6 Rename the Document

2
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After clicking OK, the file will appear in the user’s Drive folder with the appropriate name given to it in the Documents List. Notice the star in Figure 5.5 next to
the file name. If the user clicks the star, the document is given special significance
and will appear in the starred list in Google Drive. The user could star documents
that are important or frequently worked on, making them easier to access. Starring
a document is the same as starring an e-mail in Gmail.

Previously Detailed Features
In Chapter 4, many of the same commands were discussed. Please refer back to
Chapter 4 to learn how to perform the actions in the following list. This section will
focus only on Presentation-specific commands, and some may overlap.
•
•
•
•
•
•
•
•
•

Share
New
Rename
Make a Copy
Revision History
Language
E-mail Collaborators
E-mail as Attachment
Print Options

FILE MENU
The File menu is usually the first menu that computer users come into contact with.
Most word-processing programs have similar features, but Google Presentations
provides some pleasant surprises that other programs can’t compete with. Read this
section to become familiar with Google’s presentation maker.

Import Slides
Import slides is a command that will let the user import slides from any Google
Presentation and/or Microsoft PowerPoint files that are located on the user’s Google
Drive or on the computer’s hard drive. Google recognizes the ubiquity of Microsoft
Office and wants to make using Google Docs an easy and compatible experience.
Teachers will find this helpful with the transition to Google Presentations because,
just like with Documents, users can upload any file type to store in their cloud storage space, Google Drive. Teachers may have created many PowerPoint presentations
in the past that are useful for their classes. To use them, teachers can convert them to
Google Presentations or insert specific slides from Google Presentations or Microsoft
PowerPoint into Google Presentations. Remember, working with Google Docs
allows the user to store and edit work from any computer with Internet access.
Students in the new economy of the 21st century will most likely not be required to
learn only one piece of software. The Common Core State Standards or the Next
Generation Assessment consortia have not endorsed any software as of yet, and
there is doubt that they will. It is key for the college- and career-ready student to be
able to be adaptive in any software to do the job. That is why Google Docs is so
important. It has all of the basic features of the mainstream office packages, but it has
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the ability to use the Internet to create, collaborate, and share, plus it is free. If a student can be comfortable with Google Docs’ toolbars, then he or she can master any
program the testing companies or their future bosses can throw at them.
Follow the steps below to import slides from other presentations, including
Microsoft PowerPoint, from the user’s Google Drive.

Figure 5.7 Importing Slides

2
1. Click Import slides from the File menu in the upper right-hand corner of
Presentations to reveal the window in Figure 5.7.
2. Select the Google Presentation
or the Microsoft PowerPoint
presentation
that the user wants to import by placing a check mark in the box as in Figure 5.7.
3. Click on which slides to import as shown in Figure 5.8.
a. Slides selected will appear highlighted like in Figure 5.8.
4. Select Keep original theme to import backdrop, colors, and other features.
5. Click

at the bottom of Figure 5.8.

Figure 5.8 Selecting Slides to Import

4
1

PRESENTATIONS

To upload slides from a presentation that is not
in the user’s Google Drive, but located on the user’s
computer, follow these steps:

Figure 5.9 Upload Slides From Computer

1. Click Upload under Presentations as seen in
Figure 5.7.
2. Drag Google Presentation or Microsoft
PowerPoint files only from your computer into
the box to upload them, or press the
button to select files manually from your hard
drive to import.

More Reasons Google
Presentations Work
Using Google Docs is perfect in a school setting. Google Docs are device neutral.
It doesn’t matter if the computer lab has iMacs and the mathematics teachers have
PCs, no software has to be purchased, and no programs have to be downloaded.
Students can move from device to device without the worry of losing information or
not having the right program.
Teachers who want to avoid creating “dead” presentations can convert their
existing PowerPoint presentations to Google Presentations or at least start making
presentations exclusively in Google Docs. A dead presentation refers to the information being locked into one saved file on one storage device like doing a Microsoft
PowerPoint. Revive presentations by converting them into a Google Doc. This gives
life to the work because the information is stored in the cloud: the user can edit the
information from any computer or share it with anyone in the world. No longer do
teachers and students have to be chained to a physical hard drive.
If users don’t want to convert documents but still want to share them the Google
Docs way, they can upload the file and click share just like sharing a Google Doc.
This is another way that Google strives to make it easy on users.

Download As
Download as is the command that lets the user download the Google Presentation
as any of the supported file formats. Presentations supports the following file types
for download.
•
•
•
•
•
•

PNG
JPEG
SVG
PPTX
PDF
TXT

Students who want to submit presentations as part of a science fair or other public events may be required to have specific formats other than the Google Docs format. Some formats such as PDF are very difficult to edit, unless you have expensive
software. This would be ideal for teachers and students who do not want their information changed on the presentation when they share a digital copy with the public.
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Publish to the Web
Publish to the Web allows the user to publish the presentation directly to the Web,
giving it a unique URL. This option will make the presentation easy to share with
anyone with Internet access. Teachers may use this option when presenting to a class;
they need only to get the presentation’s unique URL and copy and paste it into an
e-mail to share the presentation with students. When the user clicks on the link, the
presentation will appear in the browser. The URL is long and confusing. Use Google’s
URL Shortener, http://goo.gl, to shorten the link. This makes it easy for the user to
share the presentation. This is helpful when the presenter does not have the e-mail of
the participants but wants to share the presentation with a group. The participants
will type the shortened URL into a browser’s address bar to view the presentation.
Another dazzling way to access Google Presentations or any documents created
in Google Docs on the Web is through the use of QR codes. QR codes allow the user
to access the information on smartphones or tablets without typing in the URL. See
QR codes and Google URL Shortener in Chapter 11 for more details.

INSERT MENU
The Insert menu gives users many options to make their presentations come alive.
Read the next section to become familiar with inserting graphic design elements to
make your presentations stand out.

Video
Videos can be uploaded from YouTube into Google Presentations. There is not an
upload from hard drive option for videos. Teachers and students could create a
YouTube account to upload videos. Some domain administrators allow students and
teachers to link their YouTube and Google Apps accounts, allowing them to fully use
this feature in presentations. Some districts may not feel that it is in the best interest
of their students and faculty to have this option because of inappropriate content.
Google owns YouTube, making integration with Google Apps easy. The only problem is that the district domain administrator must allow YouTube for Schools to be
turned on in the Google Apps domain. Contact your domain administrator and ask
him or her to allow YouTube for Schools. It is understandable that some schools may
opt out of giving students access to the YouTube site. Alternatively, there is YouTube
for Schools. In this version, all comments and advertisements are taken off the site.
If YouTube for Schools is unblocked for students, they can post their own videos into
their Google Presentations. If your school has this capability, follow the steps in the
following two options to insert existing YouTube videos into presentations.

Option I: Insert YouTube Video From Search
1. Select Video from the Insert menu in the upper left side of Presentations.
2. Click Video search as indicated in Figure 5.10.
3. Enter a search term into the search box.
4. Press the play icon
5. Click

in the middle of the video thumbnail to preview.

to choose that video to be inserted in the presentation.

PRESENTATIONS

Figure 5.10 Insert YouTube From Search

2

3
4

5

Option II: Insert YouTube Video From URL
Each YouTube video has its own unique URL, exactly like every Google Doc and
Google Calendar. To place specific videos into presentations, follow these steps:
1. Select Video from the Insert menu in the upper left of presentations.
2. Click on the initials URL as shown in Figure 5.11.
3. Copy the URL from the YouTube website.
4. Paste the URL into the space provided.
5. Press

to insert the video.

Figure 5.11 Insert YouTube Video From URL

2

4
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Word Art
Word art is a way for students and teachers to add creativity to their presentations. To insert Word Art into Presentations, follow these steps:
1. Select Word Art from the Insert menu in Presentations.
2. Enter text into the Word Art text box as shown in Figure 5.12.
3. Enter multiple lines by holding Shift+Enter.
4. Press Enter when finished to insert the Word Art.
Figure 5.12 Inserting Word Art

Word Art can be edited for the following designs by selecting the drop-down
menu when the Word Art is highlighted on the slide.
• Fill color

.

• Line color

.

• Line weight
• Line dash
• Font

.
.
.

• Bold, italic, underline

.

These options allow users to express their unique style. View Google’s Demo
Slam video at http://goo.gl/Fvsev to see what is possible with presentations with
respect to Word Art, lines, shapes, and other media.

Animate
Animations are a great way to give life to a presentation. The Common Core
State Standards encourage the use of multimedia as detailed in the fifth-grade standard shown in Table 5.5. This Common Core standard pushes students to use multimedia components to enrich concepts being presented. Teaching appropriate style
Table 5.5 Speaking and Listening Standard 5.SL.5
Include multimedia components (e.g., graphics, sound) and visual displays in
presentations when appropriate to enhance the development of main ideas or themes.

PRESENTATIONS

is essential for college and career success. Students must recognize audience and
present in a style appropriate to the task.
Follow the steps below to add slide transitions in Google Presentations.
1. Select Animate from the Insert menu in the toolbar of Google Presentations.
2. Select the drop-down arrow next to the word Slide as shown in Figure 5.13 to add

Figure 5.13 Adding Slide Animations/Transitions

2

slide transition to the current slide.
3. Choose from the list of animations in Figure 5.13.
To animate a particular object on the slide, follow these steps:
1. Select Animate from the Insert menu in the toolbar of Google Presentations.
2. Select an object to animate on the slide.
•
•
•
•

Graphics
Images
Word Art
Text boxes
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3. Click +Add Animation to reveal the options located in the drop-down menu in
Figure 5.14.
4. Choose which animation style and command to place on the object shown in
Figure 5.14.
5. Repeat Steps 2–4 to select additional objects for animation.
6. Select
selected.

underneath +Add Animation to preview animations you have

Figure 5.14 Animate an Object

4

3

Line
Inserting lines into presentations is a great way for students to express themselves artistically while exploring geometry concepts. For example, the type of line
called Polyline is great for learning shapes and their names in early grades math
classes. Polylines are used to make polygons. Common Core State Standards for
geometry in the third grade directs students to analyze and create shapes. For
example, students could draw polygons on their slides, name them accordingly,
and share them with other students. One idea is to create databases of study materials organized in folders stored on the teacher’s Google Drive. An example of a
database would be slides with explanations and drawings of polygons. These
databases could be shared with students when studying a particular shape and its
properties. This is a great way to review for a test or send home as a study guide.
Once the slideshow is shared with the class, students can access it anywhere they
have connection to the Internet. In a perfect world, students would study their
materials from their smartphone as they ride home on the school bus. Take this
idea one step further by collaborating with other classes or other schools. Since

PRESENTATIONS

Common Core is a national initiative, sharing relevant materials
with classes all over the country could help.
To insert lines into Presentations, follow these steps:

Figure 5.15 Types of Lines

1. Select Line from the Insert menu at the top of Presentations to
reveal the drop-down menu containing the types of lines that
may be inserted as shown in Figure 5.15.
2. Click on which type of line to insert.
3. Edit the line.
4. Highlight the line by clicking on it to reveal the toolbar and dropdown menus that can change:
• Fill color
• Line color
• Line weight
• Line dash
• Arrowheads

; these are placed at the beginning and end of the line to

give it direction

LESSON IN FOCUS
Classroom Activity With Lines
Students in third grade must “reason with shapes and their attributes.” This mathematics standard
wants students to understand that shapes have similarities and differences. For example, a student
learning this standard could make a presentation. The teacher may prepare slides in advance that
have the names of shapes on them. Follow the steps laid out here to make the lesson a reality in your
classroom.

The teacher will . . .
1. Create a Google Presentation with each slide containing names of various shapes students
are studying.
2. Share the premade presentation with the students.

The students will . . .
3. Make a copy of the presentation by selecting File, then Make a copy.
This step lets the student take ownership of the shared document. Any further edits that the
student makes to the document will not appear on the original.
4. Rename the presentation using the naming convention selected by the teacher.
5. Research on the Internet properties of the shapes and their appearance.
6. Use Polyline to draw the shapes, then name them appropriately.
7. Use the Internet to give research information about the shapes to summarize on the slide.
8. Re-share the new presentation with the teacher for scoring.
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TECHNOLOGY-INFUSED TEACHING TIP
Writing on slides in the lower grades is important. It may be difficult for a third grader
to write in the large white space of a traditional document. Working with slides gives
the students a smaller space with a defined area to work in. This is great way to build
skills of producing content with technology using the Internet.

TECHNOLOGY-INFUSED TEACHING TIP
Students who are college and career ready will be prepared to write in many different
mediums. Documents such as Microsoft Word, Apple’s Pages, or Google Documents
are not the only way to present formal writing. Websites, blogs, wikis, Twitter,
Facebook, and countless other not-yet-invented formats in which people consume
information will be important. Promote other formats; students who are versatile will
be college and career ready. The standard in Table 5.6 seeks to expand students’ ability
to read and write in diverse media.

Table 5.6 Integration of Knowledge and Ideas Anchor Standard 7 for Reading
Integrate and evaluate content presented in diverse media and formats, including
visually and quantitatively, as well as in words.

New Slide
To insert a new slide, follow these steps:
Figure 5.16 New Slide Layouts

1. Click the

icon in the left side of Presentations.

2. Click the drop-down arrow next to the red plus sign to
select from the slide layouts shown in Figure 5.16.
The slide layouts shown in Figure 5.16 pertain to what
type of text and object boxes will appear on the slide for the
particular layout. For example, the Title and Body slide will
have a text box for the title of the slide and a separate text
box for the body of the slide. If the user wants to create his
or her own text and object boxes select the Blank layout.

Concerns With Collaborative Work in
Presentations
When working collaboratively, students need to be
aware of which slides they have permission in which to

PRESENTATIONS

work. Many times in collaborative presentations, students will be assigned a
specific slide number for their contribution. For example, if a student added
a slide to the middle of the groups’ presentation and every student was assigned
a slide number in which to work, then the slide numbers would be changed,
causing confusion. If the teacher predefines the slides and does not allow adding
slides to the middle of the presentation, then the confusion can be averted. To
help avoid the bewilderment, use the chat feature built into every Google Doc.
This helps if a small group is working on a presentation project. Users can chat
about whatever they need to on the side. This helps collaborators be organized
when unexpected changes occur in the making of the presentation. Google Docs
chat is automatically turned on even if chat in Gmail is disabled. This is great
because the domain administrator would have to disable all of Google Docs features to keep students from collaborating. Learn how to chat in Presentations by
reading the next section.

Chat in Google Docs
Chat in Docs is located in the upper right-hand corner of any Google Doc.
When others are viewing, the users can chat with each other. This is helpful when
working collaboratively. They are able to talk with each other, discussing the
presentation and ideas that they have to make it better. Collaboration is one of
the key features of the Common Core State Standards. The word collaboration is
mentioned 39 times in the Mathematics and English language arts standards.
Whether the student is working on a math proof in Presentations or using the
space to create online notecards to study with a friend, collaboration is at the
heart of Google Apps for Education. The chat feature can make this collaboration
a reality. To access chat in Google Docs, follow these steps:
Figure 5.17 Chat in Docs

1. Click the drop-down arrow denoting how
many viewers are collaborating on the document located under the comments and
share buttons as shown in Figure 5.17.
a. The names of the viewers are located
here with a colored box.
b. The color box represents their cursor
color on the document.
2. Type text in the chat box, then press Enter.
a. Chat will automatically pop up in the
other viewers’ windows.

Google Presentations for
Research Notecards
Consider this Common Core State Standard
in Table 5.7 when planning long-term or shortterm writing projects with students.
Presentations can be used in more ways

1

2
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Table 5.7 A
 nchor Standard 10 Writing Standards for Literacy in History/Social Studies,
Science, and Technical Subjects 6–12
Write routinely over extended time frames (time for reflection and revision) and shorter
time frames (a single sitting or a day or two) for a range of discipline-specific tasks,
purposes, and audience.

than a simple performance of conveying knowledge to a formal group of spectators.
For example, a student researching information about certain historical figures for a
history/social studies research paper would find presentations a useful tool for organization. The student will undoubtedly find many resources in print and digital formats as the Common Core State Standards express routinely. Taking notes on
traditional note cards does not pave the way into the 21st century. Using Google
Presentations as research notecards is both efficient and convenient. The content created in Presentations is always stored in the cloud and accessed anywhere there is an
Internet connection. Students are able to modify their research with their smartphone
or home computer. The research will be shared with the teacher so the teacher can give
feedback in the form of comments. Comments are used in Documents, Spreadsheets,
Presentations, and Drawings as a way for teachers to grade or leave feedback on
assignments. Presentations allows the teacher to guide the student in the writing process from research to final draft.

Other Uses for Presentations
Figure 5.18 Insert Shapes

•
•
•
•
•

Flash cards
Note-taking
Writing projects for elementary students
Teacher presentations for content
Student presentations for content

Shapes
In Presentations, users may insert various
shapes, arrows, callouts, and equation elements that enhance the presentation. Look at
Figure 5.18 for the full collection of shapes that
may be inserted into a presentation. Encourage
students to use these transitional elements to
make eye-catching flowcharts and graphics. To
insert shapes, follow these steps:
1. Select Shapes from the Insert menu located
in the toolbar in Presentations.
2. Hover the mouse over the arrow pointing to
the right beside Shape
to reveal
the objects available for insert as shown in
Figure 5.18.
3. Click the object to insert and edit it accordingly.

PRESENTATIONS

SLIDE MENU
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Figure 5.19 Change Background

Many of the features in the Slide menu are
offered in other presentation makers and
are self-explanatory. We will learn only
about the background option in depth.

1

Background

2

Under the Slide menu in the toolbar is
background. Background is different than
theme. The background refers to the color
or image on the background of the slide,
and it can be applied to all slides or a particular slide. Theme refers to the arrangement of text boxes, titles, and body of the
slide. When students are working on collaborative projects, they may change the
background color or image to their preference without changing the group’s background as a whole. Teach the students to
be aware of the Apply All button. To
change the background, follow these steps:

3

1. Select Background under the Slide menu in the toolbar to reveal Figure 5.19.
2. Click the drop-down arrow next to the box to change the color

.

3. Click
to select an image from your Google Drive, search the Web, or
upload from your hard drive.
4. Click

to reset the theme to default.

5. Click Done or Apply to all.

TECHNOLOGY-INFUSED TEACHING TIP
Changing the layout and theme will affect the entire presentation. When working on
collaborative presentations, make sure to seek the advice of the group before applying
a new motif to the presentation. Use the convenient chat or comment features to consult
group members.

FORMAT MENU
Format refers to the style of text, paragraphs, line spacing, and options like bold,
italic, and underline. These are common in most office software. One exception in
Google Docs that makes it stand out from other presentation- or document-creating
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software is the Alt Text utility. This feature will help students with special needs
who have difficulty seeing or reading the text on the presentation. Alt Text works
with third-party screen-reader software to deliver text to speech for individuals with
text deficiencies. Some of these third-party software programs will work with
Google Docs to print in Braille. Google Presentations can help everyone learn
regardless of their learning or physical disability. If you have access to the screenreader technology, try it for your students. To access Alt Text, follow these steps:
1. Select a piece of text on the slide.
2. Select Alt Text from the Format menu in the toolbar.
3. Title and describe the Alt Text as shown in Figure 5.20.

Figure 5.20 Alt Text

Example of Student Work
In this example, students are using presentations to create collaborative slide
shows about soil in eighth-grade science class. The teacher, Ms. Jacquie Dubrava,
prepared ahead of time a presentation titled “Soil.” The presentation she shared had
one title page and one individual slide for each student in the class. She shared the
presentation with the entire class period easily by using the share settings and selecting the sixth-period group that she had previously created (see Chapter 3: Gmail). In
the first slide, Ms. Dubrava gave directions and slide assignments to the students.
Students were assigned to create a slide covering an aspect of what they have
learned about soil within the unit of study. Students were assigned which topics to
cover in their slide. Each student was given a particular slide number in which to
work. All students in the class were working on the presentation at the same time.

PRESENTATIONS

By the end of the class period, the students had created a full collaborative presentation covering every aspect of soil that they have learned about. Follow the link
http://goo.gl/NJwQ1 to see an example from her seventh-period class.

SUMMARY
Presentations are one more component of Google Apps for Education that will help
students and teachers meet the rigor of the Common Core State Standards. The standards addressed in this chapter undoubtedly can be met with the use of presentations. Moving forward, each part of Google Docs will become increasingly familiar.
Start to think how you can use these great tools for collaboration in your classroom
to exceed the expectations of the Common Core State Standards.

RESOURCE LINK
Lesson Plans
Digital copy found at the link.
Lesson plans with numbers are in
order in the resource section.

Grade Level

Lesson Plan Title

Elementary
School

Biomes by Ronna Van Veghel

http://goo.gl/ILJ3V

Online
Only

Middle School

Peter Pan by Betsy Davis

http://goo.gl/l9XmX

#6

High School

Introduction to the Salem Witch
Trials by Heather Eggers

http://goo.gl/wmf7h

#7

For additional resources, including lesson plans, videos, and video tutorials, access this link:
 http://goo.gl/aFR1q
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